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Abstract

Changes in blood vessels and lymphatics in health and disease are easier to understand and 

interpret when studied microscopically in three dimensions. The mouse trachea is a simple, 

yet powerful, and versatile model system in which to achieve this. We describe practical 

immunohistochemical methods for fluorescence and confocal microscopy of wholemounts of the 

mouse trachea to achieve this purpose in which the entire vasculature can be visualized from 

the organ level to the cellular and subcellular level. Blood vessels and lymphatics have highly 

stereotyped vascular architectures that repeat in arcades between the tracheal cartilages. Arterioles, 

capillaries, and venules can be easily identified for the blood vessels, while the lymphatics consist 

of initial lymphatics and collecting lymphatics. Even small abnormalities in either blood vessels 

or lymphatics can be noticed and evaluated in three dimensions. We and others have used the 

mouse trachea for examining in situ angiogenesis and lymphangiogenesis, vascular development 

and regression, vessel patency, differences in transgenic mice, and pathological changes, such as 

increased vascular permeability induced by inflammatory mediators.
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1 Introduction

The increasing availability of transgenic mice, specific antibodies, and confocal microscopes 

has made wholemount preparations more attractive for studies of angiogenesis and 

lymphangiogenesis. To date, numerous tissues have been examined as wholemounts, 

including the retina, cornea, choroid, meninges, skin, intestine and mesentery but the 
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attributes of the mouse trachea are not well known. Yet, wholemounts of the trachea yield 

vastly more three-dimensional information than histological sections. The purpose of this 

chapter is to present practical step-by-step immunohistochemical methods for preparing the 

mouse trachea for studies of blood and lymphatic vessels by fluorescence and confocal 

microscopy.

This model system has been used by our laboratory and others for examining angiogenesis 

[1] and lymphangiogenesis [2], many other features including vascular development, 

remodeling and regression [3], testing therapeutic drugs [4], blood vessel patency [5, 6], 

vessel differences in transgenic mice, and changes in pathological conditions, such as 

increased vascular permeability in response to inflammatory mediators [7, 8] or infectious 

organisms [2].

2 Materials

2.1 Mice for Studying Blood and Lymphatic Vessels in Mouse Trachea

1. Tracheal blood vessels and lymphatics have been studied in wild-type and in 

several transgenic strains of mice. Rat tracheas can also be processed in a 

similar way but are thicker and more difficult to make flat. We have used 

doxycycline-regulated double-transgenic mice where the expression of a growth 

factor, e.g., VEGF-A [1] or VEGF-C [1] or marker of interest is driven by a 

doxycycline-responsive promoter gene Scgb1a1 that is expressed in secretory 

Club cells found in the epithelium of trachea and large bronchioles (JAX strain).

2. Prospero homeobox 1-enhanced green fluorescence protein (Prox1-EGFP) 

transgenic mice have been particularly useful for studies of lymphatics and 

are available from the Mutant Mouse Resource Center at the University of 

California Davis as strain MMRC and from laboratories that use them [9], 

Although the endogenous green fluorescence of lymphatics in these mice fades 

rapidly after paraformaldehyde fixation, it can be amplified and made permanent 

by immunohistochemical staining for EGFP. Prox1-EGFP mice can be easily 

genotyped by the presence of green fluorescence of Prox1-EGFP in lens cells 

after a bright light is shined into their eyes.

3. Mice should be housed under pathogen-free conditions in filter-top cages 

to avoid accidental respiratory tract infections, which can have profound 

remodelling effects on airway blood vessels and lymphatics.

2.2 Anesthetics

Ketamine (87 mg/kg) plus xylazine (13 mg/kg) are injected intraperitoneally together in the 

same syringe (see Note 1).

2.3 Perfusion Apparatus

1. 1-L aspirator bottle with a hose outlet at the bottom (VWR/Kimax) is used for 

perfusion of fixative.
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2. An aneroid sphygmomanometer (Medline) is used to generate a fixed pressure 

for perfusion of fixative from the aspirator bottle.

3. Silicone tubing and rubber bung are used to connect the sphygmomanometer and 

perfusion tubing to the aspirator bottle.

4. Male Luer-to-Luer adapters (Cole Palmer Cadence) attach the silicone perfusion 

tubing to an 18-gauge plastic catheter (Becton Dickinson), 30 mm in length that 

serves as the perfusion cannula.

5. A plastic tray similar to a restaurant dinner tray serves as a perfusion table that 

collects fixative during the perfusion.

6. The perfusion board is made from cork or a thick sheet of silicone or polystyrene 

foam (Styrofoam).

7. Surgical tape (e.g., 3 M) tape is wrapped around the front and hind paws of 

anesthetized mice and push-pins are used to fix the tape to the perfusion board.

8. A rubber band attached to front teeth and perfusion board is used to keep the 

neck and trachea straight during the perfusion.

9. A shadow-free surgical lamp is used for illumination during surgery, perfusion, 

and dissection.

10. 70% ethanol is used to moisten mouse fur before surgery and dissection.

2.4 Instruments for Surgery and Dissection

1. 140-mm long coarse scissors are used to open the chest.

2. 90-mm long fine scissors from Fine Science Tools #14060–09 are used to cut the 

heart and trachea.

3. Hemostat (locking clamp) with curved smooth tips is used to clamp tubing from 

perfusion bottle.

4. Hemostat (locking clamp) with straight serrated tips is used to clamp the rib cage 

after opening the chest wall.

5. Dumont 11-cm straight forceps from Fine Science Tools are used for dissection.

6. Coarse straight forceps (10 mm long with serrated tips from Fine Science Tools 

are used for surgery and dissection.

7. Scalpel handle and rounded or straight scalpel blades are used for surgery and 

dissection.

8. Fine scissors from Fine Science Tools are used for fine dissection.

9. A shadowless surgical light provides ideal illumination during the perfusion.

10. A binocular dissecting microscope is useful for fine dissection.
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2.5 Fixatives, Buffers, Reagents, Incubation Solutions, Embedding Medium, Etc.

1. Fixative: 1% paraformaldehyde in 1× phosphate-buffered saline (PBS)

Fixation is with 1% paraformaldehyde. See Making 1% paraformaldehyde.

2. Calcium and magnesium-free PBS and PBS-Triton

The composition of 1× PBS is 0.2 g/L KH2PO4, 2.16 g/L Na2HPO4.7H20, 0.2 

g/L KCl, 8.0 g/L NaCl. Store at room temperature. 1× PBS is conveniently 

prepared by diluting PBS 10× concentrate (GenClone) with water 1:10. Make 

PBS-Triton by adding 3 mL of Triton-X 100 (Fisher) to 1 L of 1× PBS. Stir with 

magnetic stirrer until dissolved.

3. “Immunomix” antibody incubation medium

“Immunomix,” consisting of 1× PBS containing 0.3% Triton-X 100, 0.2% 

bovine serum albumin (BSA, Sigma), and 0.1% sodium azide as an 

antibacterial agent (Sigma), is used for primary antibody incubations for 

immunohistochemistry. Can be stored at 4 °C for many months. When doing 

immunostaining using primary antibodies raised in goat or sheep, omit the 0.2% 

bovine serum albumin, as it can cross-react with the goat or sheep antibodies.

4. “SuperDAPI” mounting medium

“SuperDAPI” consists of VECTASHIELD with DAPI mounting (Vector Labs) 

with additional DAPI (Sigma) at a final concentration of 50 μg/mL. See 
Subheading 3 on how to prepare (see Note 2).

5. Coverslip sealing resin

Tissues are mounted on microscope slides in Vectashield with SuperDAPI and 

the coverslips are sealed with Cytoseal (Thermo-Fisher) or nail varnish.

6. Sylgard silicone resin for making dishes to pin wholemounts

Sylgard 184 silicone elastomer resin is available as a kit (Fisher Scientific).

7. Stainless steel pins for tracheal wholemounts

10-mm long headless stainless-steel pins (“Austerlitz Minutien” insect pins: 0.20 

mm diameter, Fine Science Tools) are used to pin tracheal wholemounts to the 

layer of Sylgard in 6-well dishes (any brand). 5–6 tracheas per well in a 6-well 

dish can be stained simultaneously in a diluted antibody volume of 1–2 mL.

8. Bradykinin for inducing leakage from tracheal blood vessels

Bradykinin acetate (Sigma) is more effective at inducing vascular leakage in the 

mouse trachea than substance P or histamine.

9. Fluorescent microspheres for microscopic imaging of vascular leakage

Bright red or green-fluorescent latex microspheres are available in a range of 

sizes from 20 to 1000 nm from several vendors. We use Fluospheres from 

Molecular Probes/Invitrogen (see Note 3).
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Immunohistochemical reagents

1. Antibodies and other reagents used for immunohistochemical staining of 

lymphatics and other types of cells in mouse trachea are listed in Table 1. 

Combinations of antibodies that stain lymphatics together with other cell types 

can be very informative.

2. Primary antibodies, and fluorophore-conjugated secondary antibodies (Jackson 

ImmunoResearch), are typically used at a working concentration of 0.5–2.5 

μg/mL (1:100–1:500 dilution) (see Note 4).

Pipettes and tips (10 μL, 200 μL and 1000 μL) for making antibody solutions.

Glass slides and coverslips (Fisher).

Fluorescence and/or confocal microscope.

It should have ×5, ×10, and ×20 dry objective lenses and ×40 and × 100 oil-

immersion lenses and digital camera (see Note 5).

Micrometer slide with 1 mm scale (Ted Pella).

Microscope accessories:

Immersion oil for oil-immersion objective lenses (e.g., Zeiss Immersol 518 N 

(Fisher Scientific), lens paper (Fisher Scientific) and lens cleaning liquid (EM 

Sciences) for cleaning lenses after use.

Computer with image capture software, ImageJ (https://imagej.nih.gov/ij/ImageJ 

and Photoshop (Adobe) for processing data.

3 Methods

3.1 Making 1% Paraformaldehyde Fixative

1. Formaldehyde vapor is toxic! Work in a fume hood or at ducted ventilation 

(see Note 6). To make 1 L of 1% paraformaldehyde (PFA) solution, add 10 g 

of powdered paraformaldehyde (Fisher) to a 1-L Pyrex flask with a magnetic 

stirring bar inside and a thermometer (be careful not to break it).

2. Add approximately one-third of the total final volume of distilled or de-ionized 

water. Stir with a magnetic stirrer. The result will be a cloudy white suspension.

3. Heat the suspension carefully to 55–60 °C on a hotplate with magnetic stirrer 

in a fume hood. Slowly and carefully add 1 N NaOH drop by drop until 

the suspension changes from cloudy white to clear. Only a few drops are 

needed. The suspension will suddenly turn almost clear but will contain some 

suspended fine white precipitate. If the temperature rises above 65 °C, discard 

the suspension and start over. Allow the suspension to cool and then filter it with 

coarse filter paper in a funnel to get a clear solution.

4. Add sufficient 10× PBS to achieve a final PBS concentration of 1× and allow the 

suspension to cool. When the solution reaches room-temperature adjust the pH to 
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approximately 7.4 by adding HCl or NaOH drop by drop. Adjust the volume to 

the correct final value by adding distilled or de-ionized water.

5. Store 1% paraformaldehyde at room temperature in a tightly capped bottle for up 

to 2 weeks. Do not freeze. Discard if a precipitate is formed (see Note 7).

3.2 Preparation of Antibody Incubation Medium

Add 3 mL of Triton-X 100, 2 grams of BSA, and 10 mL of 10% sodium azide solution 

to a 1-L bottle and fill to 1 L with 1× PBS. Add a magnetic stirring bar and stir slowly 

to dissolve the BSA. If you attempt to dissolve the BSA quickly, it will clump and take 

significantly longer to completely dissolve (see Note 8).

3.3 Preparation of Sylgard Resin Dishes

Instructions for polymerizing Sygard184 silicone resin are included in the 1-lb kit. Wear 

gloves. Add 1 part catalyst by weight to 10 parts resin in a plastic beaker and mix gently, 

trying not to introduce too many air bubbles into the mixture. If available, use a desiccator 

bell jar connected to a vacuum source to remove remaining air bubbles. Pour the resin into 

shallow plastic 6-well dishes or similar containers to a depth of 5–10 mm. Allow the viscous 

liquid resin to polymerize overnight on a flat surface.

3.4 Preparation of SuperDAPI Mounting Medium

To prepare SuperDAPI, make DAPI stock solution by dissolving DAPI dilactate (Sigma) at 

1 mg/mL in deionized water. Store this DAPI stock bottle in the dark at 4 °C. Next, take a 

fresh 10 mL dropper bottle of Vectashield mounting medium (H-1000). Pipette 500 μL of 

DAPI stock solution into an empty glass dropper bottle. Add Vectashield drop by drop and 

swirl to mix it. Repeat a few times to dilute the DAPI solution with the entire 10 mL volume 

of Vectashield and mix well. Label the bottle as SuperDAPI and keep it at 4 °C in the dark.

3.5 Fixation, Cardiac Perfusion, and Trachea Dissection

1. For studies of vascular permeability, inject bradykinin (10 mg/kg iv) and 

fluorescent microspheres (20–50 μL) mixed in the same 28-gauge insulin syringe 

via tail vein immediately before anesthesia and perfusion.

2. After anesthesia, position the mouse ventral side up on the dissection board. 

Pinch rear paws to ensure adequate anesthesia by lack of reflexes. Secure the 

mouse to the dissection board with tape around limbs and push pins. Hold the 

head flat with a rubber band placed between the teeth and two push-pins to keep 

the trachea straight.

3. Moisten the fur with 70% ethanol and cut and remove the skin to expose the ribs 

and ventral chest wall.

4. Using coarse scissors, cut the chest open to make a U-shaped flap. The base 

of the U should be at the level of the eighth rib and across the sternum. Avoid 

cutting the lungs by gently moving them out of the way of the scissors. Also 

avoid cutting the diaphragm to prevent the abdominal contents from getting in 
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the way. The vertical portion of the U should end at the level of the fourth rib. 

Reflect the chest flap and clamp it with the serrated-tipped hemostat.

5. Hold the beating heart with coarse forceps and, using the fine scissors, make a 

shallow cut about 2 mm long at the tip of the left ventricle. Gently tear open the 

left and right atria with fine forceps (don’t use scissors) to create an exit route for 

blood and perfused fixative (see Note 9).

6. Insert the perfusion catheter into the aorta through the opening in the left 

ventricle and perfuse the systemic vasculature with fixative for 2 min at a 

pressure of 120 mmHg (see Note 10).

7. When the perfusate coming out from the right atrium is cleared of blood, finish 

the perfusion by clamping the perfusion line. Rinse away any blood remaining in 

the thoracic cavity with tap water from a hose or a squirt bottle.

8. Lift up the heart by the apex, cut the main vessels with scissors and remove the 

heart.

9. Using medium straight scissors cut the trachea in the order shown in Fig. 1. 

Cutting the trachea neatly while it is still stretched under tension in situ in the 

mouse is much easier than after it has been removed. Cut the trachea along 

the ventral midline with fine scissors to make a flat whole-mount. At this point 

keep the larynx and the bronchi attached to the trachea and use these regions 

as handles to manipulate the tissue with fine forceps or for securing with pins. 

Avoid damaging the cylindrical part of the trachea. The larynx and bronchi 

cannot be made into successful flat mounts, so they are cut off at the final step 

before mounting.

10. With fine forceps carefully remove the thyroid glands, recurrent laryngeal nerves 

at either side of the trachea and any major accumulations of adipose tissue on the 

adventitial surface. But don’t worry too much about perfect cleaning, because the 

structures can be omitted from the final stack of confocal images.

11. Wash trachea with several changes of PBS for about 1 h at room temperature to 

thoroughly rinse out the fixative.

3.6 Incubation Procedure for Immunohistochemistry

1. Stretch the tracheas and pin them by the corners in the Sylgard dish, with up to 6 

tracheas per well. Incubate with gentle rotation or agitation at room temperature. 

Mount the tracheas with a gap between them and the silicone layer so that 

incubation solutions can circulate and reach both sides of whole mounts and be 

readily exchanged when washing.

2. Rinse fixative from specimens with several washes of PBS. Time is not critical, 

provided all of the fixative is rinsed out; more changes, and longer is better. 

Usually, 6 × 10 min is enough.

3. Mouse tracheas can be processed in a small volume (1–2 mL) of incubation 

medium. Incubate tracheas in antibody incubation medium containing one or 
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more primary antibodies AND 5–10% blocking serum from the host species in 

which the secondary antibodies are raised (usually goat or donkey). The blocking 

step with normal serum reduces nonspecific staining by the primary antibodies. 

Combinations of primary antibodies that are raised in different species can 

be used, e.g., rabbit + goat + rat with appropriately colored species-specific 

secondary antibodies. Incubate tissues at room temperature for at least 6 h 

(overnight is better) in a 6-well dish on a mechanical rotator.

4. After the primary antibody incubation step, wash the tracheas with several 

changes of PBS-Triton for several hours. Wash whole mounts with PBS-Triton 

for a minimum of 6 h or overnight at room temperature.

5. Incubate for 1–4 h or longer (overnight is best) for whole mounts in fluorescent 

secondary antibodies diluted 1:500 in PBS-Triton. Do not use serum in this 

step. Secondary antibodies conjugated to Cy3 can be used for the red channel, 

conjugated to Alexa 488 for the green channel, and conjugated to Alexa 647 for 

the far-red channel of fluorescence or confocal microscopy.

6. Repeat the wash step with PBS/Triton.

7. After this penultimate washing step, fix the tissues again briefly for 2 min in 1% 

PFA. This important step helps to prevent fading and preserves the fluorescence 

by fixing the labeled antibodies. Wash briefly (3 × 2 min) with PBS to remove 

the fixative.

8. If you prefer, the whole process is easily adapted permanent specimens for 

viewing by transmitted light microscopy, by using HRP-labeled secondary 

antibodies or streptavidin/biotin procedures.

9. Fluorescent polystyrene microspheres can be used to mark sites of vascular 

leakage. See ref. 7 for dose, duration, etc.).

10. Transfer the trachea wholemounts into a small volume of SuperDAPI in a watch 

glass or depression slide (VWR). The tracheas will become clear and almost 

invisible as the SuperDAPI medium infiltrates them.

11. After the final washing step, immerse the tracheas in Vectashield + SuperDAPI 

for 2–5 min in a few drops of VectaShield in a depression slide or watch glass. 

This step gives time for the mounting medium to infiltrate into the tracheal whole 

mount, which as a result, becomes more transparent.

12. Mount the tracheal whole mounts in SuperDAPI medium on glass slides, using 

as little mounting medium as possible. For most purposes, it is best to mount the 

trachea with the epithelial side up, as the blood vessels are closer to this surface 

and will be closer to the objective lens. Cover the wholemount with coverslips. 

If you have used too much mounting medium and the coverslips are floating, 

absorb the excess by blotting with paper towels.

13. Apply gentle pressure with forceps to the outside of the coverslip and a 

longitudinal stretching motion to squish and elongate the trachea. This part 

requires some practice.
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14. Carefully paint the edges of the coverslips with Cytoseal 60 (Fisher Scientific 

#831016) or nail varnish to seal them to the glass slides. This step permits any 

immersion oil to be wiped off the coverslip. Use a fume hood for this step, as 

Cytoseal 60 contains volatile and noxious solvents (toluene and butyl benzyl 

phthalate.) Allow the Cytoseal to harden for about 1 h in a fume hood at room 

temperature before viewing the slides on a microscope (see Note 11). Store 

slides in a slide box or plastic slide tray (VWR) in the dark in a refrigerator. 

Because of the final fixation, the fluorescence should last for up to 1 year.

3.7 Microscopy, Photography, and Tiling in Photoshop

1. Prior to observation with a fluorescence or confocal microscope, take the slides 

out of the refrigerator and let them come to room temperature for a few minutes 

so any condensation can evaporate.

2. Photograph the sections in appropriate color channels with camera exposure 

adjusted for brightness, contrast, and resolution. For conventional fluorescence 

microscopy, it is better to photograph red and green channels separately, rather 

than using dual band red/green fluorescence filters. Some bright fluorescence 

from one channel can bleed into the other channel. If this occurs, the bleed 

through image needs to be blackened in Photoshop (Window menu > Channels 

> select channel with bleed-through image > Edit > Fill > Black 100% > File 

> Save). Red and green channels can be pasted into R and G channels and 

separately adjusted and viewed in the Channels window (see Note 12).

3. Low magnification montages or panoramas of entire tracheas can be made by 

stitching together multiple photographs taken at a higher magnification and 

resolution. This “photo-tiling” can be done with Photoshop or other applications. 

For example, 10–20 images at 5× are usually sufficient to make a panorama of 

an entire section of mouse trachea. Images at 5× have a great depth of field, 

so almost all blood vessels and lymphatics are in focus. Photograph individual 

images so that they have about 30% horizontal and vertical overlap with adjacent 

images.

4. In Photoshop, open all of the individual images > File > Automate > Photomerge 

> select “Auto Layout” (if not already clicked) and “Blend Images Together” and 

click “Add Open Files”. Click OK. After processing, Photoshop will assemble 

the images into a seamless whole. If there are gaps in the image, the original 

photos have not had enough overlap with their neighbors and need to be 

re-photographed. Sometimes individual stray images can be dragged manually 

into the correct position in the panorama. The panorama will be in multiple 

Photoshop layers and will have a large file size. When you are sure the panorama 

is correct, flatten the multiple merged images (Layers > Flatten Image > Save as 

JPG).

5. It is useful to take a photo of a calibrated micrometer scale slide to calculate the 

final magnification of the panorama. An easy and accurate way to put a scale bar 

on your final micrograph is to take a photo of the micrometer slide at the same 
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magnification as your image. Put the photo of the micrometer slide into a new 

layer in PhotoShop, use it to make a scale bar of a suitable length, then delete it, 

leaving only the scale bar.

3.8 Pixel Intensity Analysis, Surface Plots, and Morphometry with ImageJ

1. Morphometric parameters such as the size, area density, fluorescence intensity, 

etc. of immunostained blood vessels and lymphatics in tracheal wholemounts can 

be measured with ImageJ) after image optimization in Photoshop.

2. Camera settings and Photoshop adjustments must be the same for all images in 

the batch being analyzed, because the measurement of area density is based on 

the percentage of pixels above a certain brightness threshold.

3. In Photoshop adjust the contrast and brightness of the color channel containing 

vessels of interest, such that the background where lymphatics are absent is 

almost black and the vessels are bright.

4. Launch ImageJ and open the image (File > Open > select the image of interest).

5. In the “Image” menu of ImageJ scroll down to “Color” then across to “Split 

Channels”. Keep the color channel containing the vessels of interest and discard 

the others.

6. Surface plots in ImageJ are a useful way to compare the intensity of staining in 

images. Arrange the images side by side, open in ImageJ and choose the color 

channel to be analyzed as in steps 4 and 5 above. In ImageJ Analyze menu select 

“Surface Plot”. A topographic image with mountains and valleys representing 

fluorescence intensity should be produced. To make a color-coded heat map of 

the fluorescence intensities, in the ImageJ Image menu (third from left in ImageJ 

menu) select “Lookup Tables” at bottom and choose one that works for you, e.g., 

“16 colors”. For an example, see Fig. 3c.

7. For additional analysis of your image, select the region of interest using the 

“Freehand selection” lasso tool (fourth from the left in the ImageJ icon menu).

8. In the “Analyze” menu of ImageJ scroll down to “Histogram” describing the 

number of pixels in the image with a brightness of 0 to 225. Click “Copy”.

9. Paste the data into an Excel spreadsheet, and calculate the total number of pixels 

with intensity 0 to 225 in the region of interest bounded by the yellow line.

10. Also in Excel, calculate the total number of pixels above the chosen brightness 

threshold, and calculate the percentage they represent of the total number of 

pixels. The absolute value of the brightness threshold is arbitrary but must be less 

than the brightness of the structures identified as blood vessels or lymphatics and 

must be the same for all images being analyzed.

11. A plugin called Image-based tool for Counting Nuclei (ICTN) for ImageJ, which 

can be downloaded from https://imagej.nih.gov/ij/plugins/itcn.html, can be used 

for counting nuclei of Prox1-stained lymphatic endothelial cells.
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12. Morphometric point counting can be used as an alternative to ImageJ for 

measuring area densities. For this approach, a rectangular test grid is overlaid 

on the image, and points of intersection are counted manually. A plugin to create 

such a grid in ImageJ can be accessed by clicking Analyze > scroll down to 

“Tools” > “Grid”.

13. The whole process takes 3 days from mouse to image analysis. Day 1: 

perfusion washing, mounting in Sylgard dishes and primary antibody incubation 

overnight; Day 2: washing and secondary antibody incubation overnight; Day 

3: washing, final fixation and mounting on glass slides, imaging and analysis. 

A low magnification confocal image of the architecture of mouse tracheal 

blood and lymphatic vessels is shown in Fig. 2. Examples of various useful 

immunohistochemical markers related to blood vessels and lymphatics are shown 

in Fig. 3.

4 Notes

1. Written records must be kept on the use of ketamine, as for other 

controlled substances, and made available for inspection by your institution’s 

Environmental Health and Safety (EH&S) department.

2. Vectashield with DAPI mounting medium (Vector Labs product) does not 

contain enough DAPI to properly stain tracheal whole mounts. However, it 

does contain a useful proprietary anti-fade agent than prolongs fluorescence and 

minimizes bleaching.

3. A detailed product description of fluorescent microspheres from Molecular 

Probes/Invitrogen is available at: https://www.thermofisher.com/document-

connect/document-connect.html?

url=https%3A%2F%2Fassets.thermofisher.com%2FTFS-

Assets%2FLSG%2Fmanuals%2Fmp05000.pdf&title=Rmx1b1NwaGVyZXMgR

mx1b3Jlc2NlbnQgTWljcm9zcGhlcmVz

4. Secondary antibodies (e.g., from Jackson ImmunoResearch Laboratories) that 

are pre-absorbed for other species are superior to unabsorbed ones. They are 

more expensive but result in lower background staining.

5. Any brand of microscope from a reliable maker is suitable. Low magnification 

lenses (×5, ×10, ×20) are useful for making panoramas and images with a great 

focal depth. For fluorescence microscopy, oil-immersion lenses ×40 and ×100 

provide a brighter image with more resolution, but they require more care in 

their use and have a shallower focal depth. Ordinary paper towels or tissues 

can be used for wiping and cleaning glass slides and coverslips, but NOT for 

objective lenses. Carefully clean oil immersion lenses with purpose-made lens 

paper, which can scratch and damage the lens surface. Keep the microscope stage 

clean and dry; wipe up any spilled liquid with tissue paper.

6. The Occupational Safety Health Administration (OSHA) limit for formaldehyde 

in the workplace is 0.75 parts formaldehyde per million parts of air (0.75 ppm) 
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measured as an 8-h time-weighted average, or a short-term exposure limit of 2 

ppm during a 15-min period. Check your local EH&S regulations for conditions 

for performing perfusion with paraformaldehyde solution and take any necessary 

training courses.

7. Do not freeze aliquots of paraformaldehyde in solution, as the activity will 

be lost. Do not use formalin (37% paraformaldehyde +15% methanol) as the 

fixative. Local safety regulations may require bottles to have warning labels of 

“Carcinogen” or similar. Dispose of waste paraformaldehyde in accord with local 

safety regulations.

8. Sodium azide is toxic and should be handled with care. Read the safety data 

sheet before handling it and check with local regulations and authorities for 

policies governing its use and disposal. Wear gloves, mask, and protective 

clothing. For safety, sodium azide is best stored and handled as a solution in 

a break-proof bottle surrounded by a safety container. Make a 10% aqueous 

solution by carefully dissolving 10 g sodium azide powder in 100 mL of 

deionized water.

9. When creating a route for outflow of blood and fixative during the perfusion, use 

a toothed forceps and do not cut the heart atria with scissors, as there is a risk of 

accidental cutting of the aorta or other structures by mistake.

10. In our experience, 1% paraformaldehyde solution is just as good for fixing 

mouse tissues for immunohistochemistry with most antibodies and produces 

fewer fumes than 4%. Perfusion should be done in a well-ventilated place, e.g., 

a fume hood or perfusion board equipped with approved ventilation nearby to 

minimize the danger of breathing toxic formaldehyde fumes. For safety, wear 

gloves, mask, and personal protective clothing/equipment.

11. When using objective lenses with short working distances (20× and above), be 

careful to avoid bringing the lens into contact with Cytoseal that has not fully 

hardened. If that should accidentally happen, clean off the Cytoseal immediately 

with lens paper and lens cleaning fluid.

12. If mistakes are made in Photoshop, they can be reversed by using the History 

menu window or the Edit > Step Backwards command.
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Fig. 1. 
Schematic diagram of mouse trachea in situ showing the order of cuts (dashed red lines) 

to make a wholemount preparation. 1: longitudinal cut along ventral aspect of trachea; 2 

and 3: cuts along bronchi; 4: cut across larynx; 5 and 6: cuts across bronchi. The resulting 

wholemount is shown on the right
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Fig. 2. 
Vasculature of adult mouse trachea. Whole mount preparation showing the vasculature of 

the adult trachea (endothelial cells, PECAM-1, green) with pericytes and smooth muscle 

cells (desmin, red) at P70. Long axis of the trachea oriented horizontally. (a) Confocal 

micrograph showing ladder-like arrangement of capillaries (arrows) that span three cartilage 

rings. Most arterioles, venules, and weakly stained lymphatic vessels (*) are confined to 

regions between cartilages. Bar: 50 μm. Boxed regions are enlarged in c, d. (b) Cartilages 

(arrows) of entire panel a are shown here in a brightfield image. (c) Arteriole with densely 

packed circumferentially oriented smooth muscle cells and a weakly stained lymphatic (*). 

(d) Venule and capillaries with obliquely or longitudinally oriented pericytes stained for 

desmin. Scale bar in d: 50 μm in a, 150 μm in b, and 20 μm in c, d. (Image reprinted with 

permission from Ref. [3])
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Fig. 3. 
(a, b) Capillaries over tracheal cartilages of transgenic mice at (a) baseline and (b) 7 

days after doxycycline-induced overexpression of VEGF-A overexpression in VEGF-A 

transgenic mouse. Abundance of angiogenic vessels and increase in VEGFR-2 expression. 

Bar: 50 μm. (c) ImageJ surface plot showing increase in VEGFR-2 expression (fluorescence 

intensity) of A, B. (d, e) In mice, the tracheal vascular plexus is remodeled over the 

first week of neonatal life. (d) Endothelial cells first undergo apoptosis at P3, as shown 

by activated caspase-3 (arrows), and later (e) growth at P7 as shown by phosphohistone 

H3 (arrows). Arrowheads indicate other dividing cells. Bar: 20 μm. (f) Increased vascular 

permeability shown by extravasation of 100-nm green-fluorescent microspheres (arrows) 

from tracheal venules 4 min after bradykinin challenge (10 mg/kg iv). Numerous 

intravascular leukocytes adherent in venules (arrowheads) are also stained by the PECAM-1 

antibody. Bar: 50 μm. (g–i) Tracheal lymphatics marked by VEGFR-3 staining at (g) 

baseline and (hi) after overexpression of VEGF-C in CCSP/VEGF-C transgenic mouse. (h) 

Doxycycline administered P0–P7, and (i) from P70-P77. Much stronger lymphangiogenesis 

in neonatal mouse. Arrows: lymphatics. Arrowheads: blood vessels. Bar 50 μm. (j) Tracheal 

lymphatic endothelial cell nuclei (arrows) labeled by BrdU staining 3 days after induction of 

VEGF-C in CCSP/VEGF-C transgenic mouse. Arrowhead marks mitotic cell. Bar: 20 μm. 
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(k, l) Proliferating lymphatic endothelial cells marked by staining for p-4E-BP1 (arrows). 

Arrowheads mark lymphatic sprouts. Bar: 50 μm in K and 10 μm in L. (Images reprinted 

with permission; a–c from Ref. [1], d, e from Ref. [3], f from Ref. [7], g–i from Ref. [10], 

and j–l from Ref. [5])
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Table 1

Markers of endothelial cells in blood vessels and lymphatics and other cells in mouse trachea

Cell type Marker Host Vendor Catalog # Comments

Vascular endothelial cells

PECAM-1 (CD31) Armenian 
Hamster Rat

Thermo BioLegend MA3105 102502 Clone 2H8 Clone MEC13.3 
Weaker expression also on 
lymphatic EC

VE-cadherin 
(CD144)

Rabbit Goat 
Rat

Millipore/Sigma 
R&D Systems BD 
Biosciences

MABT886T 
AF1002 550548

Clone VIi37 Clone 11D4.1

Endoglin (CD105) Rat eBioscience 14–1051 Clone MJ7/18

Endomucin Rat Goat Invitrogen R&D 
Systems

14-5851-81 AF4666 Clone V.7C7 On venules, not 
arterioles

Von Willebrand 
factor

Rabbit Dako 0082

MECA-32 (PV-1) Rat BD Biosciences 550,563 Clone MECA-32

Endothelial 
glycocalyx

Lycopersicon 
esculentum lectin

Plant Vector Laboratories DL-1174–1

Endothelial 
glycocalyx

Griffonia 
simplicifolia 
isolectin B4

Plant Vector Laboratories FL-1201–5

Endothelial 
basement 
membrane

Collagen-IV Rabbit CosmoBio LB-1403 Strong on blood vessels and 
collecting lymphatics

VEGF receptor VEGFR-2 Goat R&D Systems AF644 Weaker expression also on 
lymphatic EC

Lumen of patent 
blood and 
lymphatic vessels

Podocalyxin Goat R&D Systems AF1556

High endothelial 
venules (HEV)

MECA-79 Rat (IgM) BD Bioscience 553,863 Found in bronchoalveolar 
lymphoid tissue (BALT)

Lymphatic endothelial cells

EGFP in Prox1-
EGFP mice

Chicken Aves GFP 1020 Overall best marker Strong 
signal. Marks cytoplasm and 
nucleus

LYVE-1 Rabbit Rat 
Goat

AngioBio R&D 
Systems R&D 
Systems

11–034 MAB2125 
AF2125

Good marker Also found on 
some macrophages

Prox1 Rabbit Goat AngioBio R&D 
Systems

11–002P AF2727 Nuclei of lymphatic EC and 
neuroendocrine cells

VEGFR-3 Goat R&D Systems AF743 Weaker signal and higher 
background than Prox1

CCL21 Goat R&D Systems AF469 In Golgi apparatus of 
lymphatic endothelial cells

Neuropilin-2 Goat R&D Systems AF564 Endothelial cells of 
lymphatics and venules

Podoplanin Syrian hamster AngioBio 11–033 Clone 8.1.1 Also expressed by some 
tracheal epithelial cells

Activity markers

Dividing cells Phospho-histone H3 Rabbit Millipore 06–570

Dividing cells BrdU Rat Abcam Ab567 Needs pre-injection of BrdU

Dying cells Activated caspase-3 Rabbit R&D Systems Cell 
Signaling

AF835 9579 Clone D3E9
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Cell type Marker Host Vendor Catalog # Comments

Adhesion molecule ICAM (CD54) Rat eBioscience 14-1061-82 Clone 429

Adhesion molecule VCAM (CD106) Rat Millipore/Sigma MAB2627 Clone 6C7.1

Adhesion molecule P-selectin Rat BD Biosciences 550,289 Clone RB40.34

mTOR activity p-4E-BP1 Rabbit Cell Signaling 2855 In lymphatic sprouts

mTOR activity p-S6RP Rabbit Cell Signaling 4858 In lymphatic sprouts

Leakage marker RCA1 lectin Plant Vector Laboratories B-1085–5 Biotinylated

Other cell types

Smooth muscle 
cells

α-smooth muscle 
actin

Mouse Millipore/Sigma F3777 (FITC) 
C6198 (Cy3)

Also marks airway smooth 
muscle cells

Pericytes NG2 Rabbit Millipore/Sigma Ab5320

Pan-epithelial cells E-cadherin Pan-
cytokeratin

Rat Rabbit Thermo Dako 13–1900 Z0622 Clone ECCD-2

Club epithelial 
cells

CCSP Rabbit Millipore/Sigma 07–623

Ciliated epithelial 
cells

Acetylated tubulin Mouse Millipore/Sigma T7451 Clone 6–11B-1

T-lymphocytes CD3e Armenian 
hamster

BioLegend 100,302 Clone 145–2C11

B-lymphocytes B220 Rat BioLegend 103,202 Clone RA3–6B2

Neutrophils S100A8 A100A9 Goat Rabbit R&D Systems 
Abcam

AF3059 Ab105472

Macrophages Iba1 Mrc1/CD206 
F4/80

Rabbit Rat Rat WAKO BioRad 
BioLegend

019–19741 
MCA2235GA 
123102

Also known as Aif1 Clone 
BM8 Better in wax sections

Dendritic cells CD11c Rat eBioscience 14-0114-81 Clone N418 Better in wax 
sections
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